VS1010C Minidemo Board
The VS1010C Minidemo board is an example of a simple board with a small component
count, but it can still do a lot of things. It can be configured, for example, to be...
•

SD card MP3 player

•

Pre-programmed player (Audio Book) with SPI flash or SPI NAND flash storage

•

USB DAC

•

USB Serial Port

•

MCU UART controlled player

•

MCU to SD card adapter*

•

MCU to USB or USB flash adapter*

*) some functionality requires custom software to be loaded to the VS1010C.

Patch and Firmware loading
Without any external memory or firmware, VS1010C ROM contains functionality to work
as an SD card MP3 player, USB serial dongle, USB serial GPIO dongle, or an SD / MMC /
eMMC card reader. Also it can show the contents of the external flash or ramdisk via USB,
so that initial board programming can be done. It can also display a command prompt to
UART or USB serial port so that the developer can control and command the VS1010C.

Additional firmware can be loaded in many ways:
•

Automatically load patch from SD/MMC/eMMC card

•

Automatically run programs from SD/MMC/eMMC card

•

Automatically load patch or run programs from SPI FLASH

•

Boot from SPI FLASH

•

Boot from SPI EEPROM

•

Boot from I2C EEPROM

•

Boot from SPI NAND FLASH (requires supported IC type)

•

Run programs from FLASH or SD/MMC/eMMC card via UART commands

•

Load and run binary code from UART using binary poke or VS3EMU protocol

•

Load and run binary code from USB (as USB Mass Storage device) using Ramdisk

•

Load and run binary code from USB (as USB serial port) using VS3EMU protocol

With a very small external memory (or via external MCU configuration thru UART) the
VS1010C can become a USB DAC or a USB High Speed (480M) SD/MMC/eMMC card
reader/writer.
With more external firmware, even very complex products can be made with VS1010C.

VS1010C Boot Order
VS1010C runs or attempts to run software in the following order:
1. SPI FLASH/EEPROM Boot record or I2C EEPROM Boot record
2. SPI FLASH hidden sector boot record
3. S:BOOT.DLX FAT file patch loading from SPI FLASH or SD card. If the spi flash is
formatted and contains a ”SYS” folder, then it becomes the system drive ”S:”.
Otherwise the SD card becomes the system drive ”S:”.
4. USB modes (USB Ramdisk, USB Serial Port, USB Mass Storage)
5. S:CONFIG.TXT based patch, driver and app loading from SPI flash or SD card
6. UART (VSIDE ,VS3EMU, or binary poke with external MCU)
7. D:VSPLAYER.DLX file patch loading from SD card
8. SD card hidden sector boot record
9. Normal SD card ROM player (plays WAV and MP3 files in alphabetical order)
10. Command line via UART terminal (115200-N81), accessed by pressing Enter.
Some USB protocols require using a serial number. USB Serial Number can be set in
SPI/I2C boot record or in S:BOOT.DLX. By default the USB serial number is 1.

VS1010C Runlevels
Different boot modes for VS1010 are called ”runlevels”. There are several different
runlevels defined in the ROM. You can also add your own runleves using CONFIG.TXT
configuration, or patching, or with SPI boot.
Runlevels 0-15 can be set with GPIO pins during boot. Others can be set with the ”reboot”
command from the command line.
Here are the VS1010C Runlevels:
Run- Config
level
.txt

ROM Defined Operation

Needs
Patch?

0

[0]

Normal Player

no

1

-

USB Ramdisk Loader / Fast SPI Boot

no

2

-

USB Mass Storage (12M): 1-bit bus MMC, eMMC or SD card

no

3

[3]

Normal Player, UART binary upload enabled

no

4

-

USB Mass Storage (12M): SPI flash read/write*

no

5

-

USB Audio Class 1: 44.1/16, 48/16, 96/16, 44.1/24, 48/24, 96/24

yes**

6

[6]

Normal Player

no

7

[7]

I2C EEPROM Boot

no

8

-

USB Serial Port***: VSOS Shell and VS3EMU Simple Loader

no**

9

-

USB Serial Port***: USB UART adapter (serial dongle)

no

10

-

USB Serial Port***: USB Serial GPIO dongle

no

11

-

VS3EMU connect. VS1010 does nothing except waits for emu.

no

12

[<]

VSOS Shell (UART0) command prompt

no

13

[=]

Normal Player

no

14

-

USB High Speed (480M) Mass Storage: 4 bit bus SD card

yes****

15

[?]

Normal Player. Default runlevel in most VS1010C boards.

no

17

[A]

Normal Player

no

18

[B]

SPI Boot disabled (other runlevels do SPI boot at startup)

no

Normal Player

no

others [C] ...

*) Shows Ramdisk if SPI flash is not detected.
**) Patch is required to enable audio with USB enabled
***) USB Communications Class is supported in Windows 10 and other operating systems.
****) Withouth patch runs in USB Full Speed (12M)

VS1010C0 ROM Patch
VS1010C is mostly functional out of the box with very few problems. The problems we
have found so far are fixed by loading a patch file. The patch is available as VSIDE
solution and as a precompiled VSOS4 executable file BOOT.DLX, which can be copied to
the SPI FLASH or to an SD CARD. The patch can also be loaded from I2C EEPROM.
The patch fixes the following issues:
•

Periodical resetting of VS1010C when POWBTN is constantly high is disabled.

•

USB High Speed (480M) mode is enabled where applicable

•

A bug which halts the CPU when USB and Audio are enabled together is fixed. This
bug affected USB Audio and playing files via USB Serial Port Command Prompt.

•

Writing to the SPI FLASH via USB is more reliable. Without the patch, the last
sector written to the flash is corrupted if there's not a read operation after the last
write operation.

Initial Flash Programming in Production
It's important that boards that contain an EEPROM or FLASH chip can be programmed
reliably and easily in production. For this purpose it is very important to make the
required pins available in the board. Initial flash programming can be done via the
following buses:
•

MMC/SD card. 3 pins are required: SD_CMD, SD_DAT0 and SD_CLK.
Don't forget power and ground.

•

UART. 2 pins are required: RX and TX. And ground.

•

USB. A suitable USB mode (Ramdisk, USB Flash Writer or USB Serial Console) must
be set with GPIO pins, or give a UART command to enter the USB mode.

In a perfect universe it would be enough to have just one of these options available on the
PCB. But in the real world you will save a lot of time, trouble and effort in production if
you make all of them available on the PCB, as well as power and ground pins.
SPI NAND FLASH chips can currently only be programmed and their content written
with an SD card. For this purpose, make the three SD bus pins as well as power and
ground available in a pin header or equip the PCB with a (micro)SD card slot.
RX and TX are needed to debug any board. Please make them available in a pin header
(does not need to be soldered in production), otherwise we cannot support or debug the
board and it may be impossible to produce. Both RX and TX need pull-up resistors.
3 resistors connected to MOSI1, XCS1 and GND can be used to provide a video console
output, which you can connect to a TV to see what the VS1010C is doing and to see debug
output and error messages. It's useful for the developer to see what is going on in the IC
when software is written.

The CONFIG.TXT configuration file
At a certain time in the Boot process, VS1010C reads the CONFIG.TXT file from an SPI
FLASH or an SD / MMC / eMMC card. The contents of CONFIG.TXT is easily editable
with a PC to configure what the VS1010C board does at startup.
CONFIG.TXT contains a set of commands that are executed during boot. It's a little like
a .BAT file in Windows and even more like a CONFIG.SYS file of DOS.
The lines before any section mark in CONFIG.TXT is encountered are always executed,
regardless of VS1010C runlevel.
Lines that consist of a character inside brackets, such as [0] mark a beginning of section.
The character is matched against the current runlevel to see if that section is executed or
not. Programs can be written to change the current runlevel as needed and an '@' sign can
be used to restart parsing the configuration file with the possibly modified runlevel.

VSOS Shell (Command Line)
VS1010C ROM contains a simple command line shell interpreter. It can be accessed via
USB or UART0 port from normal player mode by sending a Carriage Return. With a PC,
use a terminal program such as TeraTerm 4.90 and set up the serial port baudrate 115200
bps, 8 bits data, no parity, 1 stop bit, and no flow control. Additionally, in Terminal
settings, set up TeraTerm to transmit only CR (Carriage Return) for a newline, instead of
CR+LF.
To access the command line shell from the For the USB mode, boot the VS1010C in
runlevel 8 and use an operating system with built-in support for USB Communications
Class (Windows 10, Mac, Linux).
When a command is given, the search order (”path”) for the commands is:
1) Internal romdisk R root
2) System disk S folder SYS, can be SD card or SPI flash.
3) Absolute file name including the path and extension, for example F:SYS/DIR.DLX
Boot software can modify the system devices table to make R: or S: to point to any device.
In case 1, a file name is constructed from the first word of the command by adding ”R:” in
the front and ”.DLX” in the end. For example, DIR is expanded to R:DIR.DLX. If such a file
is found, then it is loaded and executed by the OS library loader.
In case 2, the file name is constructed by adding ”S:SYS/” in the beginning and ”.DLX” in
the end. For example, ECHO is expanded to S:SYS/ECHO.DLX.
The maximum length of the expaned file name is 50 characters. Giving a longer first word
from the command line will crash the system. Maximum total length of any command is
128 characters.

Figure 1. VS1010C Minidemo board version 1.0 schematics

VS1010 Developer board quick start

Illustration 1: VS1010 Developer board version 1.3

Disclaimer
This is a preliminary document version. All properties and figures are subject to change. This
document is written for a Developer Board with VS1010B device attached. With VS1010C, some
functionality is different.
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1 Required equipment
•

Developer board (ICs: VS1010, VS23S010, audio power amplifier, SPI EEPROM, I2S
ADC)

•

VSIDE USB-UART cable

•

microSD card

•

USB mini-B cable

•

VSIDE compatible computer

2 Input and output
Table 2.1 includes the various connectors, jumpers, buttons, and switches that the Developer board
has. Highlighted with gray are buttons and switches. See Illustration 1 to locate them on the actual
board.
#

Name

Description

1

LOUT

Line-out

2

HP

Headphones

3

JPR

Amplified signal from a D class amplifier to speakers

4

JPL

Same as above

5

JP2

Connects to VS1010 SAR channel AUX2.

6

LIN

Line-in

7

RESET

Reset button

8

TV1

Video-out

9

JP1

Pin header. See sub-chapter “JP1 Header” for details.

10

JP4

Provides access for XCS1 and MOSI1 signals from VS1010. Close
jumper to enable video signal.

11

JP5

Video output switch. See sub-chapter “Video output” for more.

12

JP15

Module port for external module. Gives access to the VS1010 GPIO
2_7 pin, second UART and VS23S010 GPIO pins

13

CN3

microSD slot. MicroSD card is used by the VS1010 as both the
media storage and also for storing custom application code and
console commands that can be run by the VS1010. Use the FAT32
file system.

14

JP14

Video crystal header. See sub-chapter “Video output” for more.

15

JP11

I2S Digital audio

16

CN2

PS/2 Keyboard connector

17

CN5

PS/2 Mouse connector
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18

BATT2

Battery for real time clock

19

JP7

Close jumper to ground XCS0

20

JP8

Close jumper to enable VS1010 power. (Closed by default.)

21

JP6

Analog audio signals straight from the VS1010, analog power,
ground.

22

B0

Next track, set runlevel. See chapter “Buttons” for details.

23

B1

Pause/unpause, set runlevel. See chapter “Buttons” for details.

24

B2

Used when setting runlevel, See chapter “Buttons” for details.

25

B3

Used when setting runlevel, See chapter “Buttons” for details.

26

PWR

Power on. See chapter “Buttons” for details.

27

SW1

USB connection selection switch. Positions correspond with the
locations of the connectors.

28

X1

USB Mini-B connector for connecting the board to a PC. Is currently
supported.

29

X2

USB Type A connector. Planned to be used for connecting a USB
flash memory when the software drivers become available.

30

JP3

Jumper to enable the D class power amplifier for the speakers.
Connects the VHIGH power for a regulator which provides power
for the output amplifier. (Closed by default.)

Table 2.1: Connectors, jumpers, switches and buttons. Gray highlight for switches and buttons.

2.1 JP1 Header
The JP1 header provides access to many signals connected to VS1010. It has digital audio inputs
and outputs, two UARTs, SPI and powers and grounds. See Illustration 2 for exact pin-out.

Illustration 2: JP1 Header pinout
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2.2 Video output
The Developer board provides two different video outputs from the TV1 video-out connector,
VS1010 internal video debug console and the VS23S010 color video signal. To see the VS1010
console, it's enough to close the jumper JP4, and to set the video selector switch to the position
closer to the TV1 connector. See Illustration 3 for an example.

Illustration 3: VS1010B internal debug console shown on an old industrial
CRT TV monitor
To see the color video signal, a color carrier crystal for the VS23S010 memory/video controller IC
must be connected to the header JP14. Proper frequencies are for PAL 4.433618 MHz and NTSC
3.579545 MHz. With the crystal and custom software, a color video signal can be generated with
the board. The video selector switch must be placed at the position closer to the video-out
connector. See Illustration 5 for an example.

2.3 Buttons
The VS1010 Developer Board v1.3 has six buttons. Close to the top, between LIN and JP1, is
RESET. At the bottom are the buttons B0, B1, B2, B3 and PWR. In the player mode pressing B0
will skip to the next track, and B1 is pause and unpause. The buttons are also used for selecting
different runlevels, which are in chapter 5.1.
4

3 Powering the VS1010 Developer board
Developer board can be powered through either the mini-USB plug or JP1 header. It also provides
VHIGH to USB-A connector. VHIGH should be 5 volts.
Illustration 4 shows the proper way to power the developer board using the VSIDE UART cable.
Use Illustration 2 to see the exact pin locations.
Red wire is 5V. (pin 1)
Green wire is connected to RX0 (pin 16)
White wire is connected to TX0 (pin 17)
Black wire is ground (pin 19 or 20)
Note that TX0 and RX0 are not side by side, RX0 is the third pin from the bottom of the connector.
Once the correct cables are connected, the board can be turned on by pressing PWR.
The UART signals have 3 volt levels. There are no 5 volt tolerant I/O pins on the board.
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Illustration 4: VSIDE UART cable connected to UART0

Illustration 5: VS1010B demo setup with PS/2 keyboard and the VS23S010
color video output
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4 Connecting with the UART
The provided USB-UART cable should install its drivers with Windows by simply plugging it in. If
not, you may try installing the drivers manually. See chapter “Additional Information” for
instructions.
To communicate with the Developer board, you also need a terminal program with serial port
support. There is a variety of such programs available, for example, Tera Term. Before you can
communicate with the board, you need to set up the connection settings.
For the settings, you will need the name of the COM port the USB-UART cable is using. On
Windows, go to the Device manager, find the group “Ports (COM and LPT)”, and under it “Prolific
USB-to-Serial Comm Port (COMx)”, where x is a positive integer. The COM port number is what
you need.
To set up the connection with Tera Term, for example, go to File → New Connection, choose
“Serial”, and pick the correct COM port from the list. Then go to Setup → Serial Port. The correct
settings are as follows:
Port: the COM port
Baud rate: 115200
Data: 8 bit
Parity: none
Stop: 1 bit
Flow control: none
Transmit delays: 0
The serial connection should be now running. The next chapter has some examples on how to use it.

5 Booting the VS1010
Note: SPI booting on the current VS1010 developer boards is unreliable due to chip select conflict
between the VS23S010 and the boot flash. This can be fixed in 2 ways: 1) adding a pull-up resistor
to the VS23S010 chip select signal or 2) running a patch software from the SD card. Developer
boards shipped by VLSI only support booting from the SD card by default.
VS1010 boot order:
1.
2.
3.
4.
5.

SPI EEPROM
SPI Flash
UART0 VS3EMU monitor.
SD card
Internal ROM player and the command line
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If JP7 is closed with jumper, SPI boot is skipped. This is required if SPI memory was flashed with
bad image which prevents proper booting.
After VSOS loads, console output can be seen in UART0, and in TV1 if the board is set up for it.
Sample console output:
B#0d1d
VS1010B VSOS 2.78
Files:6. Buffers:3.
Runlevel 0
SD:3796 MB

The first line is a boot status message:
“B” means VS1010B.
“0” means that SPI bus 0 (internal SPI) is selected.
“d” means “done”, e.g. no boot image is found.
“1” means that SPI bus 1 (external SPI bus 0) is selected,
“d” again means “done”, no boot image is found.
If a boot image would have been found, there would be “f” stating a flash boot or “e” stating an
eeprom boot.
Next is the chip name and the VSOS version. The line after shows the amount of file handles that
can be opened (6), and the amount file buffers (3), e.g. you can open up to 3 simultaneous disk data
files (the remaining three can be character device streams, for example).
Runlevel shows the boot state of the chip, i.e. what the chip is attempting to do. Runlevel 0 is the
default boot, and it is the player mode. The other boot modes are explained in the sub-chapter
“Runlevels”.
In the default configuration, audio files from the SD card are played. If you have configured the
serial connection, you can drop fromt the player to the VSOS shell prompt by sending carriage
return (13) to UART0. Doing so will also stop the player.
Note for VS1010B: if the player is paused during this, the shell won't open. Instead, an un-pause is
required, after which the shell will open immediately, even without another carriage return.
The VS1010B ROM has two built-in programs, “x:D” to list files and “x:T” to type text files.
Below is a sample run of them.
VS1010>x:D s:doc
File list of s:doc/*
1: .
2: ..
3: README.txt
3 file(s) found.
VS1010>x:T s:doc/README.txt
Here will be documentation for the VS1010 developer board.

More programs can be added to the SD card or, in the future, to the flash. The Developer board also
has a selection of programs which can be found in the chapter “Included system programs”.
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5.1 Runlevels
The runlevel is selected at boot by holding the buttons B0, B1, B2 or B3. The button combinations
work in binary, where an unpressed button is a 1, and a pressed button is 0. B3 is the most
significant bit.
For example, to set runlevel to 2, hold buttons B3, B2 and B0 (0b0010), and then press RESET (or
PWR, if the board isn't on already). Keep holding B3, B2 and B0 a second or two after releasing
RESET.
In VS1010B, Runlevel 1 is USB ramdisk debug mode, and runlevel 2 is USB SD card reader mode.
For VS1010C, all four buttons are used to set the boot runlevel from 15 downto 0.

VS1010C runlevels are:
0, 3, 6, 13, 15: normal SD card WAV/MP3 player.
1: USB Ramdisk loader.
2: USB MMC/eMMC/SD card reader in 1 bit bus mode (only CMD, DAT and CLK signals)
3: Normal player with UART binary poke upload enabled.
4: USB External SPI flash reader.
5: USB Audio
7: I2C EEPROM boot mode
8: USB Serial Port (Windows 10) connected to internal console and loader
9: USB Serial Port connected to UART0
10: USB Serial Port connected to 8 GPIO pins (write 4, read 4 pins)
11: VS3EMU Connect mode. Only connects to VS3EMU or VSIDE with UART0.
12: VSOS Shell (UART0)
14: USB (High Speed) SD card reader in 4 bit SD card bus mode.
18: Boot with SPI boot disabled. This mode can only be set with the command “REBOOT 18”.
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6 Using VSIDE with templates
You can find directions to the VSIDE download in the chapter “Additional documentation”.
VSIDE has a VS1010 template for a typical Hello World program.
1) To use it, launch VSIDE and navigate to File → New → Project/Solution.
2) This launches a “New Project” window with two tabs, “Solution” and “Project”.

Illustration 6: VSIDE New Project window - Solution
tab

3) Make sure you are in the “Solution tab” ( Illustration 6) and that “Create new solution based
on template:” is selected
4) From the list of solutions, find “VS1010 Solution”, choose an approriate name and save
location, and make sure that the checkbox “Empty solution (without a project)” is not
checked
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Illustration 7: VSIDE New Project window - Project tab

5) Once satisfied, click next. This will move you to the “Project” tab ( Illustration 7)
6) From the list of templates, choose “VS1010 VSOS Hello World”. If there are templates for
boards other than VS1010, you can check the box “Show only compatible templates”.
Sidenote: it's possible to give the project a name that differs from the solution's. This is somewhat useful if you
wish to test multiple programs with the same name, e.g. “vsplayer.dlx”. Multiple solutions of the same name
are obviously not allowed in the same “solutions” folder (if you use the default location), but projects can share
names, provided they are each inside their own solutions. Alternatively, you can simply rename programs
manually when needed.

7) Once you click “OK”, the necessary files will be created. You can see the typical VSIDE
interface in Illustration 8. Note: the Hello World template has more includes than the
screenshot, as most of them are unnecessary to it, however, every VS1010 program should
begin by including vo_stdio.h, even if you can build the program without it.
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Illustration 8: VSIDE graphical user interface

8) You can now either build the solution from Build → Build Solution, and then move the .dlx
to the microSD card by hand, or alternatively first set the target drive by clicking the icon in
the toolbar, and then build. The target drive icon is the rightmost icon on the build toolbar
(Illustration 9). If the build toolbar is not visible, right-click somewhere on the toolbar area
and select it from the list. The icon for the target drive may also have a red X on it
(Illustration 10), instead of the green play symbol. This changes depending on whether or
not the target drive is set to something.
Note: If you set the SD card as the target drive, the .dlx file will automatically go to the SYS
folder, not the root of the SD. With most programs this is quite useful, but some need to be
in the root for them to run automatically, mainly boot.dlx and vsplayer.dlx

Illustration 9: Build toolbar

Illustration 10: Target drive

9) To execute the binary, drop to shell and write the executable name. If the executable file is in
the folder S:SYS/, then typing the base name of the file suffices. Otherwise, type the full
path of the file.
Example:
VS1010>hello
Hello, World!
VS1010>s:sys/hello.dlx
Hello, World!
VS1010>
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7 Executing your program
In addition to the previously described UART shell, there are many other ways to execute your code
from the SD card.

7.1 CONFIG.TXT
The supplied SD card should come with a text file named “config.txt” which prints some short
welcome messages and instructions. The programs entered to config.txt are executed before the
ROM player is started.
To execute programs placed in the SYS folder, you can use the same logic as with the UART shell.
Either use the name of the function, or write the full path. You can run multiple programs after one
another, as long as each of them are on their own lines.
You can also run a different set of programs for different runlevels, by typing the runlevel in square
brackets before the programs.
For example:
[0]
echo
echo
[3]
echo
[0]
echo

Hello
Runlevel is 0
Runlevel is 3
Hello again

will print
Hello
Runlevel is 0
Hello again

for runlevel 0, and
Runlevel is 3

for runlevel 3.

7.2 \BOOT.DLX
At boot time, after initializing the SD card, if a file named “BOOT.DLX” is found in the root of the
SD card, it's automatically executed. This can be used to execute custom programs immidiately
after booting. It's also a convenient way to load patch code to the VS1010 before continuing with
the normal operation.
In the VS1010B ROM code, there is an off by one error in reporting the number of available sectors
on the SD card to the PC in USB mass storage mode. As a consequence, some operating systems
fail to show the SD card contents correctly via USB. The VS1010B Developer Board's SD card has
a BOOT.DLX file, which fixes the problem, allowing correct USB SD card reader operation.
You can also replace BOOT.DLX with your custom program, if needed. However, in most cases
using config.txt should be enough.
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7.3 \VSPLAYER.DLX
If there is a program is named “vsplayer.dlx” in the root of the SD card, it will be called by the
ROM default music player when it starts or restarts.
The supplied SD card doesn't necessarily have a program with this name, but you can add one
regardless.

7.4 Magic sector
This is a way to hide executable code into the SD card so that it is not seen or copied by generic
operating systems normal file copy dialogues. For more information contact VLSI support.

8 Included system programs
When you connect to the board using UART, you can run commands from the command line. The
commands are stored in the “System Disk”, which is a logical drive letter that can point to different
physical storage devices. In the VS1010 developer board, it points to the SD card.
The SYS folder of the system disk (SD card) contains the following programs:

8.1 DIR.DLX
The DIR program lists files.
Example:
VS1010>dir
File list of SD/SD Card S:*
1: VS1010SD
2: DOC
3: RomAppsSrc
4: SYS
5: A Little Bit (sample).mp3
6: Angels Crying (sample).mp3
7: BOOT.DLX
8: CONFIG.TXT
9: I wont let the Sun go Down (sample).mp3
10: Orinoco Flow (sample).mp3
10 file(s) found.

Example:
VS1010>dir s:doc/
File list of SD/SD Card s:doc/*
1: .
2: ..
3: Demo10-2017-03-28-16-48-sourcecode.zip
4: README.TXT
5: vs1010devboardquickstart.pdf
5 file(s) found.
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Example (VS1010C):
VS1010>dir r:
File list of ROMDISK r:*
1: DEVICES.DLX
2: DIR.DLX
3: ECHO.DLX
4: HELLO.MP3
5: LIBLIST.DLX
6: PEEK.DLX
7: POKE.DLX
8: REBOOT.DLX
9: TYPE.DLX
9 file(s) found.

8.2 ECHO.DLX
ECHO prints the parameter to the command line. This is used e.g. in the CONFIG.TXT to print out
a greeting to the user.
Example:
VS1010>echo Hello, World!
Hello, World!

8.3 TYPE.DLX
TYPE can be used to print ASCII files to the console.
Example:
VS1010>type s:config.txt
[0]
echo
echo Welcome to VS1010!
echo Press [Return] to drop to the shell.
echo
# add your own programs here:
echo Exiting to the ROM player.

8.4 POKE.DLX
POKE can be used to manipulate memory and peripheral registers.
Example 1:
VS1010>poke x:1,2
X:0x0001: 0x0000->0x0002

Example 2:
VS1010>poke x:0,1
X:0x0000: 0x0000->0x0001
X[0]Corrupted
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In example 2, a guard interrupt notifies that address 0 of the X memory is not zero and is thus
corrupted. VSOS needs the first few words of the X memory to be cleared so that any method calls
of uninitialized objects have a good chance to be properly trapped by a zero pointer call trap.

8.5 PEEK.DLX
PEEK can be used to read contents of memory locations and peripheral registers.
Example:
VS1010>peek 0xbffe
0xbffe X=0x6b36 Y=cbe6
VS1010>peek 0xbfff
0xbfff X=0x5e27 Y=61de

The above example reads the X and Y ROM checksums of VS1010B

8.6 LIBLIST.DLX
LIBLIST prints out a list of loaded libraries and the memory ranges that they occupy in instruction,
X data and Y data memory spaces.
Example:
VS1010>liblist
0: 0xf00:ROMFILE I[0x80..0x169] X[0xf00..0xf4f] Y[0xf00..0xeff]
1: 0xf50:LIBLIST.DLX I[0x16a..0x1b7] X[0xf50..0xf91] Y[0xf00..0xeff]

The listing shows that two libraries are loaded. The first one is identified only as “ROMFILE”,
meaning it's something loaded from the ROM (it's an MP3 player routine that's automatically
executed at startup). The second library is the executable program LIBLIST itself.

8.7 REBOOT.DLX
REBOOT reboots the chip from the command line.

In VS1010C, a parameter can be given to set the new runlevel after rebooting.
Example:
VS1010>reboot 4
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8.8 DEVICES.DLX
DEVICES prints out a list of currently loaded device drivers
Example:
VS1010>devices
D: SD/SD Card
I: STREAM
S: SD/SD Card
X: ROMFILE
Y: ROMFILE

In the above example, D: and S: disks point to the SD card (running in SD mode). I: points to a
serial stream receiver device. X and Y point to contents in ROM.

8.9 DEMO10.DLX
This is a very simple button controlled MP3 play file demo. The source code of this program is
included below in this document.

8.10 HELLO.DLX
A Hello, World program

8.11 HELLO.MP3
A test MP3 file which contains the OS code author saying the word “hello”. To play it, give the
PLAY command (it's an internal command in VS1010 ROM):
VS1010>play s:sys/hello.mp3
HELLO.MP3

8.12 ROMCRC.DLX
A program that prints out ROM checksums. You can use this to check which version of the VS1010
device you are using. This may be relevant if you choose to optimize your code size by linking
directly to symbols in ROM. (If possible, you should use only the VSOS standard interface in your
programs – this generates more portable code – instead of accessing any ROM symbols directly.)
Example:
VS1010>romcrc
Check ROM CRCs
Calculated IROM: ee14d38f , ROM @ dfff
contains: ee14d38f , ok
Calculated XROM: 6b36, 5e27, ROM @ bffe, bfff contains: 6b36, 5e27, ok
Calculated YROM: cbe6, 61de, ROM @ bffe, bfff contains: cbe6, 61de, ok

17

9 Custom player example
Below is an example of a custom player program that plays (about) 3 seconds of music from the
start of a file that is selected by developer board buttons. Run it from the command line by typing
“DEMO10” or add line DEMO10 to CONFIG.TXT
/// \file main.c VS1010B VSOS Executable main file
/// This is a starting point for developing VS1010 DLX libraries and executables
#include
#include
#include
#include
#include
#include
#include
#include
#include
#include
#include

<vo_stdio.h>
<volink.h>
// Linker directives like DLLENTRY
<apploader.h> // RunLibraryFunction etc
<vs1010bRom.h>
<vo_gpio.h>
<vs1010b.h>
<playerinfo.h>
<string.h>
<protocol.h>
<spitv.h>
<lcd.h>

SETHANDLER(97, MyPlayerCallback)
s_int32 samplesToPlay;
void MyPlayerCallback(AUDIO_DECODER *auDec, u_int16 samples) {
// Insert here any user interface code that you want to run
// while a song is playing, for example to stop the song
// before it ends. An example is shown below. For sample
// rate 44100, it plays 3 seconds and then stops the decoder.
// Note that samplesToPlay is initialized in PlayNamedFile();
samplesToPlay -= samples;
if (samplesToPlay <= 0) {
player.auDec.cs.cancel = 1; //Stop playing current file.
}
}
u_int16 PlayNamedFile(register const char *filename) {
player.currentFile = 0;
strncpy(player.fileSpec,filename,126);
samplesToPlay = 44100 * 3; //real sample rate is unknown before decoding starts.
PlayerPlayFile();
}
ioresult main (char *params) {
printf("VS1010 Buttons Demo\n");
printf("Press [S1] or [S3] on the devboard.\n");
while(1) {
if (!GpioReadPin(0x1c)) {
printf("Playing file A...\n");
PlayNamedFile("S:A*.MP3");
printf("Done.\n");
}
if (!GpioReadPin(0x1d)) {
printf("Playing file O...\n");
PlayNamedFile("S:O*.MP3");
printf("Done.\n");
}
}
return S_OK;
}
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10

Additional documentation

Various additional documentation can be found at http://www.vlsi.fi/:
The VS1010 Developer board schematic: Support → Evaluation Boards → VS1010 Developer
Board → Additional Information → Schematic
VS1010 and VS23S010 documentation: Products → (device model) →Additional Information
VSIDE: Support → Software → VSIDE
USB-UART cable drivers: link to a forum topic with the download can be found at the end of
the previously described VSIDE page
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